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   Chapter 

Understanding Lion 
Application Menus and 
Shortcuts 

In this chapter, we will cover the menus and shortcuts included in a few of the more 

useful applications that ship with your Lion operating system: the Finder, Safari, and 

iTunes. Lion ships with many applications, but these three are the ones you’ll use most 

often to enhance your overall desktop experience. 

General Application Menus 
Nearly all apps for your Mac—and that includes those that ship with Lion—include a 

menu system that allows you to navigate through their various features. Menu categories 

commonly included with most apps include File, Edit, View, Go, Window, and Help. To 

illustrate how you can use menus to get more out of the Lion OS, we’ll begin by taking a 

look at the menu system of the Finder (see Figure 3–1). 

The Finder 
The Finder’s menus exhibit a lot of the traits you will see in just about every other 

program you will use on the Lion OS. Notice that the application’s name—Finder—is 

shown in the leftmost menu category. All Lion applications follow this convention. All 

Lion applications also employ a common menu placement for some menu options. For 

example, the first few items that appear under the menu that contains the application’s 

name generally provide similar functionality. Specifically, they provide information about 

the app; they let you tailor the program to suit your needs and preferences; or they let 

you adjust certain aspects of the program to improve its performance and functionality, 

based on the type of Mac that you have. In the case of the Finder, the first item listed 
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under the Finder menu is About Finder; selecting this option reveals important 

information about the Finder. 

 

NOTE: Remember that we are using the Finder because it nicely illustrates how to use menus in 

Lion. And while it does show many common features you should expect to see in other 
applications, the Finder may show more or fewer options than you’ll see in those other 
applications. Let’s take a look at some of the menu features commonly found in the leftmost 

menu that contains the application name (use Figure 3 1 as a guide for this section). 

 

Figure 3–1. The Finder app’s Finder menu options 

You can see that there are several options available under the Finder menu (see 

Table 3–1 for a detailed explanation of each menu option). 
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Table 3–1. What the Finder Menu Options Do 

Menu Option Description 

About Finder Selecting the About [program name] option will let you know in detail what 

version of a program you are working with. This option will often list the authors 

of the program, copyright information, and where you can find support or 

contact information. Often, software authors will release updates and patches to 

improve the functionality of their software. For example, they might release a 

security patch to address the latest threats over the Internet. In many cases, the 

software developers will request that the user check the current version of the 

program that is running to determine whether the available patch or upgrade is 

necessary. Selecting the About [program name] option is where you go to 

figure out whether you have a version of the software that needs updating. 

Preferences... Almost all of the software that runs on Lion includes a Preferences... option. 

Selecting this option lets you turn various program features on or off, so you can 

change the way the program works to better suit your style of computing. The 

Preferences... option often provides a broad view of a program’s options, 

telling you at a glance how changing the value of a particular option will affect 

the way the program runs or operates. This is a valuable submenu item, one 

that you will find yourself using time and time again. It is helpful to remember 

that, if you don’t like the way a given program behaves, you might be able to 

use this menu option to change its behavior more to your liking. 

Empty Trash... You will not see this option in every application; however it is very common, and it 

does exactly what you would expect it to do. That is, it allows you to empty your 

computer’s Trash Bin, thereby freeing up space on your hard disk. You will learn 

more about the Secure Empty Trash… option later in this book. 

Services Clicking the Services submenu item will reveal an entire list of options for you to 

choose from. This list can consist of application- and/or Lion-specific options. 

The particular options you see will depend greatly on the application you’re 

using, so it is best that you simply explore what is available here as you use 

different programs. This is a good place to find hidden gems like text to speech, 

which allows you to highlight text in a word processing application and have 

your computer say that text aloud to you! Powerful options like these are often 

found only in the Services menu; keeping your eye on the functionality exposed 

here can significantly enhance your productivity. 

Hide The Hide submenus let you do one of three things: 

Hide [application name] (i.e., Hide Finder in this example): This menu item allows 

you to hide the application you are currently using completely from view. 

Hide Others: This menu item allows you to hide all other applications from view, 

so you can concentrate on the app you’re using. This is a common feature, one 

that is available in almost every application. This feature works system-wide, 

allowing you to manipulate the position and appearance of the windows you are 

using to interact with various applications. 

Show All: This brings back all of the items you have previously chosen to hide. 
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Reviewing the File Menu 
Most applications that run on Lion also include a File menu; the Finder app is no 

exception. This menu allows you to perform many basic actions, such as save files, 

open new files, and perform various other actions related to file maintenance (see 

Figure 3–2). The options in this menu will vary greatly from application to application; 

however, you will also see many similarities between the items listed here in most 

applications. 

   

Figure 3–2. The Finder’s File menu options 

As is commonly the case, the Finder includes a wealth of items under its File menu. I 

recommend that you take the time to review an app’s File menu before you begin to use 

the app in earnest; this will ensure that you know your options for manipulating an app’s 

files from the outset. 

Drilling Down on the Edit Menu 
An app’s Edit menu allows you to perform system actions such as Cut, Copy, and 

Paste (see Figure 3–3). Most applications allow you to do some type of copying and 

pasting, either within the application itself or between that application and other 

applications you might have open. This extremely useful feature can significantly 
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increase your productivity because it allows you to share information between various, 

often unrelated applications. For example, assume you want to copy text from a 

Microsoft Word document to an Adobe Photoshop document. The Copy and Paste 

features exposed by the Edit menus in those apps enable you to accomplish that task. 

 

Figure 3–3. The Finder’s Edit menu options 

Exploring the View Menu 
An application’s View menu enables you to manipulate that app’s visual options. For 

example, the Finder’s View menu lets you arrange the icons and file items you see in 

the Finder in various ways (see Figure 3–4). We covered a few of these options in 

Chapter 2: “Getting Around in Lion”; however, the View menu gives you an additional 

way of accessing the Finder’s visual options. The number and scope of the options you 

see in this menu can differ dramatically from application to application. For example, 

Microsoft Word’s View menu lets you select between different page-layout views, such 

as Outline and Print Layout. 
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Figure 3–4. The Finder’s View menu options 

Zipping Around the Finder’s Go Menu 
The Finder’s Go menu provides the ultimate list of shortcuts. Note that the Go menu is 

only visible when you have the Finder application selected. This menu allows you to 

jump to many sections of your Mac quickly, reducing the time it takes to navigate from 

one part of your system to another. The options you see listed in this menu also serve as 

a great introduction to the idea of application shortcuts. 

NOTE: Shortcuts give you a fast, interactive way of navigating the Lion OS, letting you use your 
keyboard to access items and places on your system. This is a much faster way of navigating 

your system than relying solely on your mouse. For example, shortcuts let you jump from Point A 

to Point B instantly, whether Points A and B are applications or file areas on your computer. 

There are thousands of available shortcuts; however, we will ease into the subject by 

concentrating on only a few, so you aren’t overwhelmed by the sheer number of them 

available on Lion. Let’s start with the shortcuts available from the Finder’s Go menu 

(see Figure 3–5). 
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Figure 3–5. The Finder app’s Go menu options 

If you look closely at the circled area in Figure 3–6, you will notice that there are various 

symbols shown to the right of most menu options. 

 

Figure 3–6. The Go menu’s shortcut key combinations 

Shortcut Keys

Shortcut Keys
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The symbols shown in this figure indicate various key combinations you can press to 

execute the menu options. Of course, before you can use these shortcuts, you must first 

learn what each symbol represents and how it corresponds to the keys on your 

keyboard. Table 3–2 describes what each symbol is and how it maps to your keyboard. 

Table 3–2. The Mac Menu Symbols and How They Map to Your Keyboard 

Symbol Description Symbol Description 

  The Command/Apple key 

(equivalent to the Control key on a 

PC) 

  The Escape key 

  The Option key (like Alt on a PC)   The Page Up key 

  The Shift key   The Page Down key 

  The Control key (Control-click = 

Right-click) 
  The Home key 

  The Tab key   The End key 

  The Return key   The Left Arrow , Up Arrow, 

Right Arrow, and Down Arrow 

keys 

  The Enter key (on the Number Pad)   The Delete Left key (like the 

Backspace key on a PC) 

  The Eject key   The Delete Right key (also 

called the Forward Delete key) 

Using these keys in combination with the appropriate letters will yield some pretty 

interesting results. There are many other key shortcuts available; however, you will find 

yourself using the ones associated with the Finder application more often than those of 

any other application. For this reason, I am providing you with the complete list of 

Finder shortcuts available for Lion (see Table 3–3 for a list of these shortcuts). 
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Table 3–3. The Finder–Specific Shortcut Key Mappings 

Keystroke Combination Action 

Cmd-click the item Open a Sidebar item in a new window 

Cmd-1, Cmd-2, Cmd-3, Cmd-4 Switch Finder views (Icon, List, Column, and Cover 
Flow) 

Right Arrow In List view, expand a folder 

Left Arrow In List view, collapse a folder 

Return (or Enter) Rename the selected file/folder 

Cmd-Down Arrow Go into the selected folder or open the selected file 

Cmd-Up Arrow Go to the parent folder 

Cmd-[  (the left square bracket) Go back 

Cmd-]  (the right square bracket) Go forward 

Tab (Shift-Tab reverses direction) Select the next icon in Icon and List views 

Tab (Shift-Tab reverses direction) Alternate columns in Column view 

Hold down the Option key while 

mousing over long filenames 

Instantly show the long file name (for names condensed 

with a “...”) 

Double-click the column Resize 

widget 

Resize the current column to fit the longest file name 

Option-double-click the Resize 

widget 

Resize all columns to fit their longest file names 

Cmd-C, then Cmd-V Copy, then paste a file 

Cmd-drag file to disk Move a file instead of copying it (i.e., this copies the file to 

the destination, and then removes it from the original 

location) 

Cmd-Delete Move the selected files to the Trash Bin 

Cmd-Shift-Delete Empty the Trash Bin (with a warning dialog) 

Cmd-Opt-Shift-Delete Empty the Trash Bin (without a warning dialog) 
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Keystroke Combination Action 

Esc Cancel a drag-and-drop action while dragging 

Cmd-Opt-I Show the Inspector (a single, live refreshing information 

window) 

Cmd-Z Undo the last action (e.g., rename file, copy file, and so on) 

Cmd-Opt-T Hide/show the Sidebar (on the left) 

Cmd-drag Move or remove an item in the toolbar (at the top of the 

window). This works in most programs. 

With a file selected, tap the 

Spacebar key (or Cmd-Y) 

Open Quick Look 

Cmd-+  (hold down the Command 

key and press the Plus key)  

Zoom in on a Quick Look Preview 

Cmd--  (hold down the Command 

key and press the Minus key) 
Zoom out from a Quick Look Preview 

Cmd-F Find by file name 

As you can see, there are a lot of options for getting around in the Finder. And believe it 

or not, there are even more general options, which we will touch on later in the chapter. 

For now, let’s move onto the menu options in another important application: Safari. 

Safari 
You will find yourself using the Safari web browser constantly. For example, you will use 

Safari in conjunction with other applications to reference information or gather 

resources. Safari is Lion’s primary web browser; and though there are others, such as 

Firefox and Google Chrome, you will find that Safari has the tightest integration with 

the Lion operating system. What does this mean? In practical terms, it means that many 

of the shortcuts and menu items you use in Lion will also be available to you in Safari. 
These shortcuts provide you with time-saving ways to get around in the application, 

simplifying the act of web browsing. We will explore Safari in depth in Chapter 8: “It’s a 

Jungle in Here: Safari and the Internet”; for now, let’s take a look at some Safari basics, 

like its primary menu (see Figure 3–7). 
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Figure 3–7. Safari’s primary menu options 

As you can see, many of Safari’s menu categories are identical to those of the Finder; 
however, you can also see a couple new menu categories (see Table 3–4). 

Table 3–4. Safari’s menu categories not found in the Finder 

Menu Item Description 

History The History menu displays information about the web sites you have visited (see 

Figure 3–8). This menu allows you to control the degree to which Safari keeps 

track of your browsing habits, including how long records of the sites you visit 

should be retained. This menu makes it easy to keep track of where you have 

been on the Web; but it is also makes it easy to protect your privacy by restricting 

how much information about your browsing habits is retained. 

Bookmarks The Bookmarks menu allows you to bookmark, or save, locations for later 

viewing (see Figure 3–9). This is similar to the functionality provided by the 

History menu; however, there are also some notable differences. When you 

bookmark a website, you have the option to name and organize that bookmark 

according to your preferences. This is different from records of your browsing 

history, where items are automatically saved in chronological order. Bookmarks 

allow you to store and recall web links that you visit often, so that you do not have 

to type in the entire web address each time you visit. Bookmarks can save you a 

lot of time when using your web browser . 
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Figure 3–8. Safari’s History menu 

 

Figure 3–9. Safari’s Bookmarks menu 

Tables 3–5 through 3–7 list some shortcuts you may find useful when surfing the Web. 
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Table 3–5. Some Useful Shortcuts While Surfing in Safari 

Keystroke Combination Action 

Up Arrow Scroll up a page by a small amount 

Down Arrow Scroll down a page by a small amount 

Left Arrow Scroll left on a page by a small amount 

Right Arrow Scroll right on a page by a small amount 

Option-Up Arrow Scroll up a page by a full screen, minus a small overlap 

Option-Down Arrow 
Scroll down a page by a full screen, minus a small 

overlap 

Cmd-Up Arrow Scroll to the top-left corner of a web page 

Cmd-Down Arrow Scroll to the bottom-left corner of a web page 

Spacebar 
Scroll down a page by a full screen, minus a small 

overlap 

Delete Go back to the previous page in your browsing history 

Shift-Delete Go forward to the next page in your browsing history 

Page Up Scroll up a page by a full screen, minus a small overlap 

Page Down 
Scroll down a page by a full screen, minus a small 

overlap 

Home Scroll to the top-left corner of web page 

Cmd-Home Go to the Home page 

End Scroll to the bottom-left corner of the web page 

Esc If location field selected, restore viewed the URL 

Cmd-click a link Open a link in a new window 

Cmd-Shift-click a link Open a link in a new tab 

Option-click a link to a file Download a file 

Shift-click the Add Bookmark button Add a bookmark directly to the Bookmarks menu 
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Keystroke Combination Action 

Cmd-Return in an address field Open a page in a new window 

Cmd-Shift-Return in an address field Open a page in a new tab 

Cmd-Return in a search field Show search results in a new window 

Cmd-Shift-Return in a search field Show search results in a new tab 

Press and hold Safari’s Back button 
Pop up a menu showing up to ten back entries by page 

title 

Press and hold Safari’s Forward 

button 

Pop up a menu showing up to ten forward entries by 

page title 

Press and hold Safari’s Back button 

while holding down the Option key 

Pop up a menu showing up to ten back entries by page 

URL 

Press and hold Safari’s Forward 

button while holding down the Option 

key 

Pop up a menu showing up to ten forward entries by 

page URL 

Table 3–6. Shortcuts in Safari’s Bookmarks Menu 

Kestroke Combination Action 

Delete Delete the selected bookmarks 

Return Start or finish editing the name of the selected bookmark 

Tab When editing, move to the next editable cell 

Spacebar or double-click Open the selected bookmark 

Cmd-double-click Open the selected bookmark in a new window 

Option-click the New Folder 
button 

Put the selected items in a new folder 
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Table 3–7. Other Useful Shortcuts in Safari 

Keystroke Combination Action 

Cmd-A Select All 

Cmd-B Show/Hide Favorites Bar 

Cmd-C Copy 

Cmd-D Add Bookmark... 

Cmd-E Use Selection for Find 

Cmd-F Find... 

Cmd-G Find Again 

Cmd-H Hide Safari 

Cmd-J Jump to Selection 

Cmd-K Block Pop-up Windows 

Cmd-L Open Location... 

Cmd-M Minimize 

Cmd-N New Window 

Cmd-O Open File... 

Cmd-P Print 

Cmd-Q Quit Safari 

Cmd-R Reload Page 

Cmd-S Save As 

Cmd-T New Tab 

Cmd-V Paste 

Cmd-W Close Window or Close Tab 

Cmd-X Cut 
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Keystroke Combination Action 

Cmd-Z Undo 

Cmd-Shift-A AutoFill Form 

Cmd-Shift-B 
Send File To Bluetooth Device... or Bookmark this group of 

tabs 

Cmd-Shift-D Add Bookmark to Menu 

Cmd-Shift-F Full Screen 

Cmd-Shift-G Find Previous 

Cmd-Shift-H Go to the Home page 

Cmd-Shift-L Search with Google 

Cmd-Shift-N Add Bookmark Folder 

Cmd-Shift-P Page Setup... 

Cmd-Shift-W Close Window 

Cmd-Shift-Z Redo 

Cmd-Option-A Activity 

Cmd-Option-B Show All Bookmarks 

Cmd-Option-E Empty Cache… 

Cmd-Option-F Google Search… 

Cmd-Option-H Hide Others 

Cmd-Option-K Mark Page for SnapBack 

Cmd-Option-L Downloads 

Cmd-Option-M Minimize All 

Cmd-Option-P SnapBack to Page 

Cmd-Option-S SnapBack to Search 
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Keystroke Combination Action 

Cmd-Option-V View Source 

Cmd-Option-W or Cmd-Option-
Shift-W 

Close All Windows 

Cmd-D Add Safari Bookmark 

Cmd-S Save Browser Window… 

Cmd-1 to Cmd-9 
Jump to First Nine Bookmarks (Not Folders) in the 

Bookmarks Toolbar 

Cmd-? Safari Help 

Cmd-[ Back 

Cmd-] Forward 

Cmd-. Stop 

Cmd-, Preferences… 

Cmd-/ Show/Hide Status Bar 

Cmd-| Show/Hide Address Bar 

Cmd-\ Show Page Load Test Window 

Cmd-; Check Spelling 

Cmd-Shift-: Spelling… 

Cmd--(Cmd-Minus key) Make Text Smaller 

Cmd-+ Make Text bigger 

Cmd-Shift-* Get Result of AppleScript 

Cmd-Shift-Right Arrow Select Next Tab 

Cmd-Shift-Left Arrow Select Previous Tab 

Cmd-Option-> Send to... 
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As the preceding tables illustrate, Safari includes an almost endless number of shortcut 

options to enhance your browsing experience. It is not necessary to try to commit all of 

the shortcuts shown to memory. Instead, I advise you to begin by finding the shortcuts 

that you feel would benefit you the most in your day-to-day use of Safari. Once you feel 

proficient with the shortcuts that you have decided are most important to you, you can 

gradually pick up other shortcuts over time. One of the hallmarks of the Lion operating 

system is its flexibility, its ability to adapt to your computing style. The more you use the 

seemingly endless array of shortcut options in Safari and the Finder, the easier you will 

find it to do things like surf the web and navigate the your files on your system. 

iTunes 
iTunes will likely be your media application of choice. This application integrates nicely 

with the Lion OS, letting you shop for digital media, listen to music, and watch videos, 

among many other actions. Like Safari and the Finder, iTunes is easy to use, not least 

because its built-in shortcuts improve the user experience significantly. For example, 

you can iTunes’ shortcuts to switch quickly from song to song or to begin watching a 

movie instantly. In this section, we’ll take an in-depth look at the menus for iTunes and 

how they help make the already easy-to-use app even easier and more enjoyable to use 

(see Figure 3–10 for a detailed view of the contextual File menu for iTunes). 

 

Figure 3–10. iTunes’ File menu options 
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NOTE: iTunes’ Edit and View menus contain exactly the options you’d expect, based on this 
chapter’s earlier discussion of the Finder app’s Edit and View menus. For this reason, I do not 

include them in my discussion of iTunes’ menus. 

Exploring iTunes’ File Menu 
iTunes’ File menu includes several options for manipulating your playlists and media 

libraries. As mentioned previously, each Lion application has its own set of items listed 

under general menus like File and Edit. For example, comparing Figures 3–2 and 3–10 

reveals that the options listed under the File menu for the Finder and iTunes differ 

significantly. iTunes’ menus are very self-explanatory, but Table 3–8 provides some 

additional details for two of the most important items listed under iTunes’ File menu. 

Table 3–8. Breaking Down a Couple Options in iTunes’ File Menu 

Menu item Description 

New Playlist This option allows you to create new playlists from various media items you 

have purchased or downloaded into iTunes. This is a great way to listen to 

music you would like to take with you on the go, and it can tremendously 

reduce media clutter when dealing with thousands of songs and videos. 

Add to Library iTunes maintains a media library database of all of your songs and videos. This 

database is constantly being updated, depending on whether you are adding or 

deleting media. This option lets you import media into your iTunes for playback. 

Selecting this option brings up a wizard that walks you through the steps 

required to put your new media where you would like it to be. 

Using the Controls Menu 
iTunes’ Controls menu also includes some interesting options (see Figure 3–11). 

 

Figure 3–11. iTunes’ Controls menu options 
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The Controls menu provides several options (with associated shortcuts) for 

manipulating and navigating the media you play with iTunes. For example, it includes 

options to increase or lower the volume, as well as to skip back and forth between the 

chapters of your videos and movies. 

Accessing the iTunes Store via the Store Menu 
As you might guess, the Store menu gives you access to the iTunes store (see Figure 3–

12). The iTunes store is similar in spirit to the Mac App Store; however, the iTunes store 

only sells media like music and videos, not applications. You might visit the iTunes store 

to find your favorite song, rent or buy your favorite movie, watch an episode of your 

favorite television show, or view the various podcasts that you have subscribed to. In 

this section, we’ll break down the most important option on the Store menu: Authorize 
This Computer. 

 

Figure 3–12. iTunes’ Store menu options 

The Authorize This Computer option enables your specific computer to download and 

play music and videos that you purchase from the iTunes store. The iTunes service 

allows you to authorize up to five other iTunes–compatible devices that you can use as 

playback devices for the media you have purchased. Authorizing a computer device 

indicates that you permit that device to use personal information like your credit card 

and iTunes user information. For this reason, you should be cautious when authorizing 

devices for friends or family, doing so only when trust is not an issue. 

Manipulating Resources with the Advanced Menu 
Finally, let’s look at iTunes’ Advanced Menu, which allows you to perform several tasks 

related to streaming and sharing resources with iTunes (see Figure 3–13). 
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Figure 3–13. iTunes’ Advanced menu options 

Table 3–9 lists some of the more significant options in iTunes’ Advanced menu and 

what they do. 

Table 3–9. Breaking Down Significant Options in iTunes’ Advanced Menu 

Menu Option Description 

Open Audio Stream... This option allows you to insert the web addresses used to stream 

Internet radio content. Doing so enables you to stream that content 

manually. Note you don’t need to use this option unless you’re trying to 

access a resource on the Web or your local computer that does not 

automatically launch iTunes. 

Subscribe to 
Podcasts... 

This option allows you to subscribe to a podcast of your choosing. 

Note that this option is only necessary when you’re browsing the 

iTunes store or the Web, and clicking a podcast subscription link 

doesn’t work. This isn’t an option you’ll use very often, but it’s good to 

know where to find it. 

Create The Create options allow you to export your media into various 

formats, so that you can play them on different devices such as an 

iPhone or Apple TV. 

Turn on Home Sharing This option allows you to share your music and other media with other 

users on your network. Thus, users on your network can listen to or 

view the content you’ve purchased the rights to without having to 

download it themselves. 

Deauthorize Audible 
Content... 

This option is used in conjunction with your audible.com account. It 

allows you to deauthorize purchased audio books, so that they can be 

transferred from one device to another, and then reauthorized on that 

new device. 



CHAPTER 3:  UUnderstanding Lion Application Menus and Shortcuts 76 

Like the Finder and Safari, iTunes comes with many useful shortcut commands that 

can significantly improve the overall app experience. Table 3–10 lists some general 

shortcuts for iTunes, while Table 3–11 lists some shortcuts that are useful for 

manipulating your libraries and playlists. 

Table 3–10. Significant General Shortcuts in iTunes 

Keystroke Action 

Return Play the selected song immediately 

Option-Right Arrow (or Option-click the Skip 
Forward button in the upper-left corner of the 

iTunes window) 

Listen to the next album in a list 

Option-Left Arrow (or Option-click the Skip 
Backward button in the upper-left corner of 

the iTunes window) 

Listen to the previous album in a list 

Cmd-Right Arrow (or click the Skip Forward 

button in the upper-left corner of the iTunes 

window) 

Fast-forward to the next song in a list 

Cmd-Left Arrow (or click the Skip Backward 

button in the upper-left corner of the iTunes 

window) 

Rewind to the previous song in a list 

Table 3–11. iTunes’ Library and Playlist Shortcuts 

Keystroke Action 

Shift-click the Add (+) button (you can also 

drag the songs to the white area of the source 

list) 

Create a playlist from a selection of songs 

Option-click the Add (+) button Create a new Smart Playlist 

Option-click the Shuffle button Reshuffle the current playlist 

Cmd-Delete Delete the selected playlist from your source list 

without bringing up a confirmation dialog 

Option-Delete a selected playlist Delete the selected playlist and all the songs it 

contains from your library 

Option-Delete a selected song Delete the selected song from your library and 

all other playlists that contain the song 
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Summary 
In this chapter, we covered how to use the menus and keyboard shortcuts built into 

most apps to get the most out of the Lion OS. We also looked at how to zip around your 

Lion OS by leveraging the shortcuts built into the Finder. This chapter looked 

specifically at the menu options and shortcuts available in three apps that ship with Lion: 

the Finder, Safari, and iTunes. However, the lessons learned are applicable to just 

about any Lion application you might use. There are literally thousands of shortcuts 

available for Lion, and these can be combined in an infinite number of ways to make 

using Lion both easier and more satisfying. I strongly recommend that you practice 

using the keyboard shortcuts described in this chapter; doing so will make you a much 

more productive user, not just when using the Lion OS and the apps that come with it, 

but when using any of the applications installed on your computing system. 


	Chapter 3: Understanding Lion Application Menus and Shortcuts
	General Application Menus
	The Finder
	Reviewing the File Menu
	Drilling Down on the Edit Menu
	Exploring the View Menu
	Zipping Around the Finder’s Go Menu

	Safari
	iTunes
	Exploring iTunes’ File Menu
	Using the Controls Menu
	Accessing the iTunes Store via the Store Menu
	Manipulating Resources with the Advanced Menu
	Summary





